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1 Introduction to discWelder STEEL
Welcome to discWelder STEEL, the professional-level, high-resolution
DVD-Audio authoring program from Minnetonka Audio Software.
With STEEL, you can create ultra-high-fidelity DVD-Audio discs that
will allow you to play your tracks on any commercially-available
DVD-Audio player that supports the DVD+/-R/RW formats. You can
import surround and stereo tracks, as well as different bit-depth and
sample-rate tracks, onto the same disc. STEEL is easy to use and it’s an
incredible value. Here are a few points to keep in mind:
PLEASE NOTE - YOU MUST REGISTER THIS PRODUCT
WITHIN 14 DAYS OF INSTALLATION! We realize it’s not fun, but if
you don’t, it won’t run! Seriously, folks, it’s how we do business, so
please register. We’ve given you four ways to do it - e-mail, fax, phone,
or the mail. It’s easy, and it qualifies you to upgrade discWelder STEEL
to discWelder CHROME. Simply follow the on-screen prompts, either
when you install the program, or when you open it again (within 14
days of install, that is).
Space: your available hard drive space should always equal at least 2X
the program size that you wish to burn onto a DVD-R, because STEEL
always makes a temporary Disc Image to burn the disc. A safe amount
of free drive space is 10GB for a single layer disc and 20GB for a dual
layer disc.
Temporary File Folder: under “Options” on the menu bar you can set
the parameters for the temporary file destination (used while burning
the disc). Your destination folder should be on a hard drive that has
enough free space (see above).
Closing Time: STEEL needs up to 15 minutes of closing time once the
disc is written (as do all DVD-A authoring programs), because a singlelayer DVD has up to 4.7 billion bytes of data to be scanned in order to
properly format directory, lead-in and lead-out areas of the disc.
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Pause Between Tracks: A pause before a selected track plays, if
desired, is set under the Track Properties (right-click on the track name,
click on “Properties”) as a “Pause” in milliseconds - 1000 milliseconds
equals one second of pause before the track plays. There is, however, a
very short space (under a few hundred milliseconds) automatically
added before some tracks by some DVD-A players.
Mac-Friendly: for all our Macintosh-based friends, STEEL will import
AIFF files as well as WAV files, and can do so on a simple network
between Macintosh and PC computers. WAV and AIFF files can also be
imported from CD-ROM discs or Firewire (r) drives.
Multiple Copies: we recommend making a Disc Image if you’re going
to burn multiple DVD-R copies. STEEL will burn DVD-Rs from either
the currently-open session (STEEL creates a temporary Disc Image for
burning) or from a Disc Image on a hard drive.
Lil’ Sparky: the default on-screen menu background image - a steel
plate, of course - that we use as a preset contains a small picture of Lil’
Sparky at the lower right corner. Please remember that he’s our
trademarked logo guy for discWelder. Thanks and happy welding!
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2 The discWelder STEEL Main Screen
Figure 2-1 shows the discWelder STEEL Main Screen.

Figure 2-1

2.1 The Menus
These pull-down menus give you access to all the functions of STEEL.
For more information, see Chapter 5, "Menu Items".

2.2 The Browse window
You use this window to navigate to the folder that holds your soundfiles.
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2.3 The Toolbar
The Toolbar gives you one-click access to the most commonly used
menu items. For more information, see “Toolbar”.

2.4 The Soundfile window
This is where you view the soundfiles you will use to make up your
playlist in the Album window.

2.5 The Album window
The Album window is where you assemble the playlist of soundfiles
that will make up your DVD-A disk.

2.6 Disc Capacity Indicator
Called the “statusbar”, these numbers at the lower right-hand corner of
the main screen show an estimation of how much of the disc is full. For
details, see section 5.3.2,The Statusbar command
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3 Creating an Album
To Create an Album, go to the File menu and select "New". The bottom
window will now be ready to start a new Album (see Figure 3-2).

Figure 3-2
The first line of the Album is where the Album is named. To give the
Album a name, right-click on this line. A menu will appear (see Figure
3-3).

Figure 3-3
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Select "Rename Album". A window will appear on the line that lets you
enter an Album name (see Figure 3-4).

Figure 3-4
When you hit the Enter key, the new Album name will appear in the first
line (see Figure 3-5).

Figure 3-5
The first level under Album is Group. You add the Group by right-clicking on the Album line, and selecting “New Group” (see Figure 3-6).

Figure 3-6
STEEL also automatically adds the first Track line under the new Group
line.
To name the new Group, right-click on the Group line, and select
"Rename Group". A window will appear on the Group line where you
can type in a name.
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To name the first Track, right-click on the Track line, and select
"Rename Track". A window will appear on the Track line where you
can type in a name (see Figure 3-7).

Figure 3-7
You are now ready to assign soundfiles to the first Track. Use the upper
left window to browse to the folder where your soundfiles are located. A
list of all the .wav and .aiff files that are in a selected folder will appear
in the upper right window.
The 6 lines under the Track line are asking for the 6 soundfiles of your
5.1 Surround recording. The symbols stand for:
L = Left front
R = Right Front
C = Center (front center)
Lfe = LFE (Low Frequency Effect, or subwoofer)
Ls = Left surround (left rear)
Rs = Right surround (right rear)
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You assign the different soundfiles to the Track channels by drag and
drop. Drag the 6 soundfiles, one at a time, to the corresponding channel
of Track 1 (see Figure 3-8).

Figure 3-8
Note: the DVD-Audio specification allows for fewer than “5.1” channels in any Track. For example, you can have L, R, Ls, and Rs channels
only on a track, without the C or LFE channels. Simply drag the appropriate .wav (or .aiff) soundfiles to the channels you need, and leave the
undesired channels empty.
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To add another track, right-click on the Group line, and select "New
Track". A second Track will be added under the first Track (see Figure
3-9).

Figure 3-9
You can now name the second Track, and assign the 6 soundfiles (see
Figure 3-10).

Figure 3-10
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3.1 Saving your Album
Go to the File menu and click on Save As. Give your Album a filename,
and click OK.

3.2 Recording your Album onto DVD
Simply click on the red dot on the Toolbar.

3.3 Adding more Groups and Tracks
You can continue to add Tracks, up to 99 total. Right-click on the Group
line, and select "New Track". You can also add more Groups, up to 9
total.

3.4 Stereo Tracks
In addition to 5.1 Surround Sound Tracks, you can add stereo Tracks.
Just drag a stereo soundfile to the "L" channel of the Track, and STEEL
will change the track from a listing of 6 channels to a listing labeled "S",
for "stereo". You can also change the default track type from “Surround” to “Stereo” in the Track Properties section of the right-click
track menu (see section 7.1.4.2, "Track Defaults").

3.5 Multichannel Soundfiles
discWelder also recognizes multichannel .WAV and .AIFF soundfiles,
such as 5.1 surround. Just drag the multichannel soundfile to the “L”
channel of the track. The track will create one line for each channel. For
5.1 surround, for instance, the track will create 6 lines for the 6 channels. The same soundfile name will be used on each line, except that a
“(1)” through “(6)” will be added to the end of the name to indicate each
channel.
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3.6 On-Screen Menu
STEEL can automatically create an on-screen menu from information in
your Album (see Chapter 8, "On-Screen Menu").
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4 Shortcuts
STEEL has features to make it even easier and faster to create a playlist
for an Album.
Instead of dragging soundfiles to the Album window, you can doubleclick on files to send them to the bottom window. Soundfiles are copied
to the Album and placed on the Album in the order they are clicked.
When you are starting a new Album, there is only one line in the album
window (see Figure 4-1).

Figure 4-1
Since there are no tracks in this Album yet, STEEL will assume that the
first soundfile you select is the Left channel soundfile of the first Track
of the first Group. So, when you double click on a soundfile in the
soundfile window, STEEL will create the Group and a Track, and place
the soundfile into the first soundfile line of the Track (see Figure 4-2).

Figure 4-2
After placing the soundfile in the Track, the selection moves the next
soundfile line (the selection is shown by the dark line). This indicates
that the next soundfile that is chosen will go on this line. When you dou-
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ble-click another soundfile, it goes to this line, and the selection moves
to the third line (see Figure 4-3).

Figure 4-3
You can keep double-clicking on soundfiles until all the soundfile lines
are full. When the last soundfile is added to the Track, the selection
moves to the Group line (see Figure 4-4).

Figure 4-4
The next time you double-click on a soundfile, STEEL will assume that
you want to start a new Track. It will create the next Track, add the
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soundfile to the first soundfile line, and move the selection to the second
soundfile line (see Figure 4-5).

Figure 4-5
The double-click shortcut can be used anywhere in your Album; you
don’t need to start at the beginning. Lets say that, for now, you want to
leave Track 3 blank, but you want to put soundfiles into Track 4. Just
move the selection to the first soundfile line of Track 4 (by left-clicking
on it) (see Figure 4-6).

Figure 4-6
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Now, when you double-click on a soundfile, it will go into the first
soundfile line of Track 4, and the selection will move to the second
soundfile line of Track 4 (see Figure 4-7).

Figure 4-7
You can also use the double-click shortcut to replace soundfiles. Let’s
say that you accidentally put the wrong soundfile on a line. Just select
the line by left-clicking on it, and then double-click on the soundfile that
you want to replace it. STEEL will ask you if you want to replace the
soundfile (see Figure 4-8).

Figure 4-8
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5 Menu Items
This chapter describes the items in the menus at the top of the main
screen.

5.1 The File Menu
Figure 5-1 shows the File menu.

Figure 5-1

5.1.1 The New command
This command closes the Album in the bottom window, and presents a
blank window for starting a new Album. A prompt will ask if you want
to save the previous Album.

5.1.2 The Open command
This command opens a previously saved Album and places it in the
bottom window.

5.1.3 The Save command
This command saves the current state of the Album in the bottom
window, under the current filename.
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5.1.4 The Save As command
Same as the Save command, except it allows you to type in a new filename. The current state of the Album will be saved under the new name.

5.1.5 The Album Properties command
This brings up the Album Properties dialog (see section 7.1.4, "Album
Properties").

5.1.6 Most Recent Projects
Under the Album Properties command on the File Menu is a list of the
last 4 Albums that were open in STEEL. By clicking on any one of
these, the Album will be opened in the bottom window.

5.1.7 The Exit command
This closes the STEEL program.

5.2 The DVD-R menu
Figure 5-2 shows the DVD-R menu. These menu items relate to the
DVD-R recorder disk drive.

Figure 5-2
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5.2.1 The Record Disc command
This command brings up the Record Disc dialog (see Figure 5-3).

Figure 5-3
This is the window where you can tell discWelder CHROME II to actually start writing a disc. There are a number of options you can select
from this window.

5.2.1.1 Select Recorder
This brings up the Select Recorder window. This is the same as the
"Select Recorder" command on the DVD-R menu.

5.2.1.2 Test / Write/ Verify
To write your Album to a disk, select the "Write" option, and click on
the "Start" button.
If there is any doubt that your computer system can keep up with the
necessary data rate to write the disk, you can use the "Test" option.
Select "Test" and click on the start button. STEEL will go through the
entire disk writing procedure except for putting the data on the disc.
Please note: if the Test button is not enabled, it means that your burner
and/or your media does not support the Test write function.
If both Test and Write are selected, then they proceed in order when the
Start button is clicked. First, the Test is performed. If the system passes
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the Test, then the Write is performed. The amount of time needed for
each process depends on the amount of data in the Disc Image (consisting of track parameters such as number and length, surround or stereo,
bit-depth and sample-rates, etc.). Finishing the disc takes up to 15 minutes, depending on the amount of data - a single-layer DVD-Audio disc
can contain up to 4.7GB.
When the “Verify” option is checked, STEEL will verify that the data
on the newly-burned disc matches the Disc Image data it was burned
from, whether the Disc Image is a temporary one or a pre-existing Disc
Image (see section 5.2.3, "The Disc Image commands"). Verification
takes place after the disc is burned, and “Verify” can only be selected
after the “Write” option is selected. The Verification process takes the
same amount of time that the Write process takes, not including closing
time.
Note: Discs cannot be verified independently in STEEL, i.e. separate
from the “Write” process: if “Verify” is not selected before “Start” is
pressed; if the disc tray is opened after burning; or if a previouslyburned disc is in the tray.

5.2.1.3 Eject When Done
Selecting this option causes the drive door to be opened when the disc
operation is completed.

5.2.1.4 Write Speed
The speed used during disc writing may selected, or set to “Max” for the
maximum burn speed.

5.2.1.5 Number of Copies
One or more copies of the disc may be made by setting this selection.
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5.2.2 The Media Properties command
This command brings up the Media Properties window (see Figure 5-4).

Figure 5-4

5.2.3 The Disc Image commands
Before an Album can be written onto a DVD disc, the information must
be compiled to create a "disc image" on the hard drive. STEEL lets you
perform 2 different operations with disc images:
1) You can convert an Album to a disc image and save it without
making a DVD.
2) If you have saved a disc image, you can create a DVD directly from
the disc image instead of the Album playlist.
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Figure 5-5 shows the Disc Image submenu.

Figure 5-5

5.2.3.1 Create Disc Image
This command creates a disc image from the Album playlist, and stores
it as a file on the hard disk. When you select this command, it brings up
the "Create Disc Image" dialog (see Figure 5-6).

Figure 5-6
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You select a folder, and give the disc image a filename. The file is stored
with an extension of ".dim".

5.2.3.2 Write Disc Image
The Write Disc Image command reads a disc image off the hard disk,
and copies it onto a DVD. When you select the Write Disc Image command, the "Write Disc Image" dialog comes up (see Figure 5-7).

Figure 5-7
In this dialog you select a source file from the hard disk. STEEL will
then copy the image off the hard disk and onto the DVD.

5.2.4 The Erase Disc command
If you are using DVD-RW discs, you can erase a disc and re-use it. The
Erase Disc command erases the DVD-RW disc that is in the selected
drive. When you click on “Erase Disc”, you will have two choices:
“Quick Erase” removes the first PMA (Program Memory Table) and the
first TOC (Table Of Contents), which makes the disc re-recordable
without removing all the data; “Full Erase” completely erases the disc
and takes longer.
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5.2.5 The Select Recorder command
This command brings up the Select Recorder dialog (see Figure 5-8).

Figure 5-8
If you have more than one DVD-R disk drive on your system, you can
use this window to choose which one STEEL will use.

5.2.6 The Open / Close Tray commands
These open and close the disc tray on the selected DVD drive.

5.3 The View menu
Figure 5-9 shows the View menu.

Figure 5-9
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5.3.1 The Toolbar command
The Toolbar command lets you show or hide the Toolbar (see Chapter 6,
"The Toolbar"). Clicking on the Toolbar menu item toggles the checkmark on and off. When the checkmark is present, the Toolbar is shown.
When the checkmark is gone, the Toolbar is hidden.

5.3.2 The Statusbar command
In the lower-right-hand corner of the discWelder STEEL screen (see
Figure 5-10) you will find a set of numbers indicating the size of your
current project in gigabytes (GB) and the percentage of disc capacity
utilized. This is the Disc Size Estimation area of the Statusbar. .

Figure 5-10
A checkmark next to “Statusbar” in the View menu makes it visible.
Right-clicking in this area will allow you to choose a disc size - 3.95 GB
for DVD-4, 4.7 GB for DVD-5, or 8.4 GB for dual-layer DVD-9, that
will serve as a basis for the disc size warning (see Figure 5-11). .

Figure 5-11
The numbers in the Statusbar will change from black to RED if the estimation of the size of your album exceeds 95% of the capacity of your
chosen disc size.
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5.3.3 The File View command
The File View command controls the way in which the files will be
displayed in the soundfile browsing window. Clicking on File View
brings up a submenu (see Figure 5-12).

Figure 5-12
When List is chosen, only the filenames are displayed. When Details is
chosen, the windows displays filenames, the duration on the recording,
number of channels, audio format, and the date modified.

5.4 The Options menu
Figure 5-13 shows the options menu.

Figure 5-13
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5.4.1 The Temporary File Folder command
Clicking on this menu item brings up a dialog (see Figure 5-14).

Figure 5-14
This dialog allows you to specify which folder is used for temporary
files. Setting this directory correctly is important, because DVD image
files can easily be several gigabytes in size.

5.5 The Help menu
Figure 5-15 shows the Help menu.

Figure 5-15

5.5.1 The Online Help command
The Online Help command brings up the STEEL online help. This
information is in HTML format. This command will start up your
default web browser, which will display the help files.
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5.5.2 The About STEEL command
Clicking on About STEEL brings up an information dialog (see Figure
5-16).

Figure 5-16
This window will display the version number of this copy of STEEL,
and also displays copyright and contact information.
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6 The Toolbar
Figure 6-1 shows the STEEL toolbar.

Figure 6-1
The toolbar gives you quick access to the most commonly used functions, without needing to go to the menus.

6.1 New
This command closes the Album in the bottom window, and presents a
blank window for starting a new Album. A prompt will ask if you want
to save the previous Album if it has been changed.

6.2 Open
This command opens a previously saved Album and places it in the
bottom window.

6.3 Save
This command saves the current state of the Album in the bottom
window, under the current filename.

6.4 About
This command gives you the version number of your STEEL program.
It also gives you contact information for Minnetonka Audio Software.
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6.5 Record
Click on this button when you are ready to record a disc. This is the
same as the "Record Disc" command in the DVD-R menu (see section
5.2.1, "The Record Disc command").

6.6 Media
This brings up the Media Properties windows. This is the same as the
"Media Properties" command in the DVD-R menu (see section 5.2.2,
"The Media Properties command").

6.7 Image
If you want to perform an operation with a disc image on the hard drive,
click on this button. This is the same as the "Disc Image" command on
the DVD-R menu (see section 5.2.3, "The Disc Image commands").

6.8 Select
If you have more than one DVD drive, click on this button to select
which drive you are using. This is the same as the "Select Recorder"
command on the DVD-R menu (see section 5.2.5, "The Select Recorder
command").

6.9 Open
This opens the tray on the selected DVD-R drive.

6.10 Close
This closes the tray on the selected DVD-R drive.
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7 Right-Click Menus
Right-click menus provide an easy way to navigate to the many functions of STEEL.

7.1 Album right-click menu
Figure 7-1 shows the Album right-click menu.

Figure 7-1

7.1.1 Clear Album
This removes all the Groups and Tracks from the current Album.

7.1.2 New Group
This adds a new group to the playlist.

7.1.3 Rename Album
If your Album does not have a name, this will allow you to name it. If
your Album already has a name, this will allow you to change the name.
This command opens a window on the Album line, where you can type
in the name.
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7.1.4 Album Properties
This selection will bring up the Album Properties window (see Figure 72).

Figure 7-2
This window shows a preview of the onscreen menu. To the left of the
preview are the controls for setting the properties of the menu. Across
the top of the window are controls for setting other Album properties.

7.1.4.1 Album Title
This window displays the name of the Album (see Figure 7-3).

Figure 7-3
You can use this window to enter an Album name, or to change an
existing Album name. This window does the same thing as the "Rename
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Album" command on the Album right-click menu (see section 7.1.3,
"Rename Album").

7.1.4.2 Track Defaults
The Track Defaults window lets you set the default channel assignments
and the default mixdown parameters (see Figure 7-4).

Figure 7-4
When you click on the down-arrow, you get to choose between 2
channel stereo and 5.1 surround. This determines how many blank
channels appear each time you create a new track.

7.1.4.3 Downmix Properties button
This button allows you to set the default downmix parameters. When
you click on this button, the Downmix Properties window appears (see
Figure 7-5).

Figure 7-5
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The downmix properties are used to determine how a 5.1 surround
sound track will be played on a stereo sound system.
In the Album properties, this only sets the default parameters when a
new track is created. You can later go to the track properties and adjust
the parameters on a track-by-track basis.

7.1.4.4 Set Cache Directory button
The Cache Directory is not the same as the Temporary File Folder. As a
default, though, the Cache Directory is a subdirectory of the user's
current Temporary File Folder.
The Cache Directory is set and saved on a per-album basis. The Temporary File Folder is set on a per-user basis.
The Cache Directory holds generated files that take a relatively long
time to generate and would be useful to have around in case you wanted
to burn another copy of your album. In the case of additional burns
(after the first when the files would first be generated and placed in the
Cache Directory) the files (like background images encoded into
MPEG-2 files) would already be present. This saves a bunch of time.
Temporary File Folder files are only meant to exists for the lifetime of
the actual burning process. Cache Directory files are meant to persist
between burns.

7.1.4.5 Hidden Group button
The DVD-A format allows you to have a single Bonus Group: that is, a
Group that will normally not appear on the menu. A Bonus Group is
given a 4-digit password, and the consumer must navigate to the Group
using the player’s Group navigation mechanism and enter this password
to make the Group appear. The Bonus Group is always the last Group in
your Album.
Please note: You can only hide one Group, and only the last Group.
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Clicking on the Hidden Group button brings up a dialog for entering the
4-digit password (see Figure 7-6). The default value is “0000” which
means “don’t hide”.

Figure 7-6

7.1.4.6 Mirror VIDEO_TS checkbox
This is a software option to the discWelder STEEL 2.5 program. When
the option is available, placing a check in the checkbox causes
discWelder to create a “hybrid” disc. This makes the disc compatible
with DVD-Video-only players. For more information, see Appendix C:
The Auto Mirror option.

7.1.5 On-Screen Menu
Checking this box will put a text menu (consisting of your Album title
and the Track names from the Album playlist superimposed over a
preset image) onto the screen of a TV connected to the video output jack
of the DVD-A player (see Chapter 8, "On-Screen Menu").

7.1.5.1 Text Properties
To set the properties for the on-screen menu text, choose a font, select
from the style options (Normal, Italic, Bold, Bold Italic, Underline),
select a size (12 to 36 point), and select a color (Black, White, Gray,
Black Outline, or White Outline). For more information, see section
8.2, "Text Properties".
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7.1.5.2 Background Image
You can place a still image in the On-Screen Menu background (see
section 8.1, "Menu Background Image").

7.1.5.3 Still Images
You can display a still image as each track plays. For more information,
see section 8.3, "Still Image Properties".

7.1.5.4 Menu Columns
Your on-screen menu can display up to three columns. For more information, see section 8.4, "Menu Columns".

7.2 Group right-click menu
Figure 7-7 shows the Group right-click menu.

Figure 7-7

7.2.1 Clear Group
This removes all the Tracks assigned to this Group.

7.2.2 Remove Group
This removes the selected Group from the Album.
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7.2.3 Insert Group
This creates a new Group and places it directly above the selected
Group.

7.2.4 New Track
This creates a new Track at the bottom of the Group.

7.2.5 Rename Group
This lets you name an unnamed Group, or change the name of a named
Group. When you select Rename Group, a window opens up on the
Group line so you can type in a new name.

7.3 Track right-click menu
Figure 7-8 shows the Track right-click menu.

Figure 7-8

7.3.1 Clear Track
This removes all the soundfiles that are assigned to the Track.

7.3.2 Delete Track
This removes the highlighted Track from the Group.

7.3.3 Insert Track
This inserts a new Track in the Group above the highlighted Track.
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7.3.4 Rename Track
This lets you name an unnamed Track, or change the name of a named
Track. When you select Rename Track, a window opens up on the Track
line so you can type in a name.

7.3.5 Track Properties
When you select Track Properties, it brings up the Track Properties
window (see Figure 7-9).

Figure 7-9

7.3.5.1 Track Title
This displays the name of the Track. You can change the Track name in
this window.
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7.3.5.2 Pause
STEEL can insert a “Pause” between tracks of up to 10 seconds. RightClick on the Track line, click on “Track Properties”, and enter the
desired pause between the selected track and the previous track in milliseconds. Please note: Pause is only available if “Gapless” is not
selected.
Track Pause is indicated by the “P” symbol under the “Info” column
(see Figure 7-10).
Figure 7-10
The Pause symbol indicates that a pause exists between the selected
track and the PREVIOUS track (see Figure 7-11).

Figure 7-11

7.3.5.3 Gapless Tracks
It is possible in discWelder STEEL to have consecutive Linear PCM
tracks (with identical Track parameters - see the Note below) play
without a gap or pause (silence) between them. Normally, depending on
the DVD-A player, there is a very small gap between consecutive
tracks. STEEL lets the producer specify that adjacent tracks play
without a gap or pause, i.e.”Gapless”. STEEL also allows a pause to be
specified, in milliseconds (see the “Pause” section above), between
tracks if desired.
Note: Gapless play is ONLY possible between Linear PCM tracks with
identical channel formats, bit-depths, and sample-rates.
Another Note: Some players do not support gapless playback. Even
though the Tracks are specified as gapless in discWelder STEEL, they
may still not play gaplessly on some players.
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To make a track Gapless, Right-Click on the Track line, click on the
Track Properties button, then click on the Gapless checkbox (which is
active ONLY if Gapless play is possible - see Figure 7-12).

Figure 7-12
Checking this box will make the playback between the selected track
and the PREVIOUS track Gapless. The Gapless track symbol is a
“G”(see Figure 7-13)

Figure 7-13
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This symbol under the “Info” column indicates that the track is Gapless
with the previous track (see Figure 7-14).

Figure 7-14

7.3.5.4 Channel Format
This displays the format of the selected Track. You can chose either 5.1
Surround or Stereo.
If 5.1 Surround is selected, you can set the downmix properties (see
Chapter 7.1.4.3, "Downmix Properties button"

7.3.5.5 Still Image
discWelder STEEL lets you have one still image for each Track.
When you create a new track, discWelder STEEL automatically places
the discWelder default image on each Track.
A thumbnail of the image is displayed.
To delete the image: Click on the image file pathname (listed under
“Image File”). This will select the file, and it will be highlighted in
blue. Then the Delete and Properties buttons will become available.
Click on the Delete button to get rid of the image.
To add a new image: After the default image is deleted, the Add button
becomes available. Click on the Add button, and browse to the image
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file that you want. After you select it, the file pathname will be listed
above, and a thumbnail of the image is displayed (see Figure 7-15).

Figure 7-15
To view the Still Image Properties, click on the Properties button. For
more information on Still Image Properties, see section 8.3, "Still Image
Properties".

7.4 Soundfile right-click menu
Figure 7-16 shows the soundfile right-click menu. This menu appears
when you right-click on a soundfile line in the Album window.

Figure 7-16

7.4.1 Delete File
This removes the soundfile from the Track.
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7.4.2 Change File
This lets you replace the soundfile with a different soundfile. When you
click on "Change File", a dialog appears (see Figure 7-17).

Figure 7-17
In this dialog, you select the new soundfile and hit the "open" button.
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8 On-Screen Menu
discWelder STEEL can automatically create an on-screen menu from
the Album and Track titles in your Album playlist. The consumer can
use the DVD-A player’s remote control to navigate through this menu
on the TV connected to the player’s video output, and select tracks to
play.
To bring up the on-screen menu properties, Right-Click on the Album
line of your Album playlist, click on Album Properties, then select "OnScreen Menu" and click on Menu Properties. This brings up the Menu
Preview window (see Figure 8-1).

Figure 8-1
The right side of the screen shows a preview of the menus that will
appear on the TV screen when playing the finished DVD-A disc. Please
note: if a Track name is too long to display, the name will be truncated
followed by a "...".
To the left of the preview screen are the controls to set the Font Properties, the Background Graphic, and the Still Image Properties.
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8.1 Menu Background Image
You can place a still image in the menu background (see Figure 8-2).

Figure 8-2
To place a background image on the menu, click the Select Image
button, and browse to your graphics file. The file must be .BMP, .TIF,
or .JPG format. The resolution of the picture depends on which TV
System is selected. For a 525/60 system (this is NTSC, used in North
America, Japan, and other parts of the world), the allowable resolutions
(in pixels) are:
720 x 480
704 x 480
352 x 480
352 x 240
For a 625/50 system (this is PAL, used in Europe, Asia, and other parts
of the world), the allowable resolutions (in pixels) are:
720 x 576
704 x 576
352 x 576
352 x 288
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STEEL will indicate the resolution of the image chosen in the “Background Image” section (see Figure 8-3).

Figure 8-3
There will be a WARNING if the chosen image size is outside the
allowable resolutions (see Figure 8-4).

Figure 8-4
To remove a background image from the menu, click on the Clear
Image button. To return to the discWelder STEEL default background
image, click on the “Default” button.
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8.2 Text Properties
discWelder STEEL lets you control the appearance of the text in the
menu, including font, style, size, and color (see Figure 8-5).

Figure 8-5
When you change a text property, the change takes effect immediately.
You will see the change in the Menu Preview window.

8.2.1 Font
You can select from any of the TrueType fonts that are installed in your
Windows system.

8.2.2 Style
The styles available for most fonts are Normal, Italic, Bold, Bold Italic,
and Underline.

8.2.3 Size
Font sizes in the drop-down list range from 12-point to 36-point.
However, you can type in numeric values up to 71-point and the
selected text font size will follow.
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8.2.4 Color
Colors include Black, White, Gray, Black Outline, and White Outline.

8.3 Still Image Properties
Figure 8-6 shows the Still Image Properties button.

Figure 8-6
When you click on this button, the Still Image Properties window
appears (see Figure 8-7).

Figure 8-7
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8.3.1 Aspect Ratio
If the images you place on the disc were made to fit a standard TV
screen, select "4:3". If your images were made for a wide-screen TV
format, select "16:9".

8.3.2 Display Mode
This feature is only available when 16:9 is selected as the aspect ratio.
For display mode, you can choose “Only Pan-scan”, “Only Letterbox”,
or “Pan-scan and Letterbox”.

8.3.3 TV System
This sets the picture to work on the TV system of the intended viewer.
Generally, North America and Japan uses "525/60" (NTSC) and Europe
uses "625/50" (PAL).

8.3.4 Default Effects Settngs
When the TV screen switches from picture to picture, it can be done in a
number of different ways, such as a fade-in and a fade-out, or a diagonal
wipe. Each track can be customized to use a different effect. The
Default Effects Settings determines the effects on each new Track
before the Track is customized.
The Start Effect Mode determines how the picture will be drawn onto
the screen. The Period determines how long it will take to draw the
picture. Similarly, the End Effect Mode determines how the picture will
be erased from the screen. The Period determines how long it will take
to erase the picture.
Note: Some players do not support still image effects other than Cut.
Even though the image effect is defined as Fade or some other effect,
the effect may not appear as specified on some players.
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8.4 Menu Columns
You can specify up to 3 vertical columns for the On-Screen Menu text.
Figure 8-8 shows the pull-down Menu Columns selection.

Figure 8-8

8.5 Tuning Up the Menu
The best approach to tuning up your on-screen menu is to wait until the
Album playlist is complete. With everything in place, you can now
experiment with the text properties, and use the menu preview to adjust
for best appearance and readability.
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9 Appendix A: Allowable audio formats
STEEL allows you to record Stereo or 5.1 Surround recordings in DVDA-format onto a DVD-R disk.

9.1 Stereo recordings
Stereo recordings can have sample rates of 192, 176.4, 96, 88.2, 48, or
44.1 kHz. Bit depths can be 24-, 20-, or 16-bits.

9.2 Multichannel recordings
Multichannel recordings, such as 5.1 surround, can have sample rates of
96, 88.2, 48, or 44.1 kHz. Bit depths can be 24-, 20-, or 16-bits.
PLEASE NOTE: 5.1 Surround recordings with bit depths and sample
rates of 24/96, 20/96, 24/88.2, or 20/88.2 require mandatory MLP
encoding (see “Appendix B, MLP”). An MLP encoder is not included
with STEEL, nor does STEEL accept MLP files. To get around this
limitation, STEEL has a unique feature called ReSolution (see Chapter
10, Appendix B: ReSolution)
If you want to record MLP-encoded files consider discWelder
CHROME. discWelder CHROME can accept files from an external
MLP encoder, such as Minnetonka Audio’s SurCode MLP.

9.3 Multiple formats for different tracks
The DVD-A spec and STEEL allow for different tracks to have different
formats. For instance, Track 1 could be 24/48 5.1 Surround, Track 2
could be 24/192 Stereo, and Track 3 could be 16/44.1 Stereo.

9.4 Different formats on a single track
In the DVD-A specification, 5.1 Surround recordings can have one
audio format on some channels, and another format on others. To do
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this, DVD-A views 5.1 recordings as having 2 channel groupings. The
allowable groupings for 5.1 are shown in Table 1.

Table 1
Channel Group 1

Channel Group 2

L,R

C, LFE, Ls, Rs

L, R, C

LFE, Ls, Rs

L, R, Ls, Rs

C, LFE

The soundfiles in Group 1 can have sampling rates of 96, 88.2, 48, or
44.1 kHz. The soundfiles in Group 2 can have sampling rates identical
to Group 1. In addition, if Group 1 has a sampling rate of 96, Group 2
can also have a sampling rate of 48. If Group 1 has a sampling rate of
88.2, Group 2 can also have a sampling rate of 44.1.
The soundfiles in Group 1 can have bit depths of 24-, 20-, or 16-bits.
The soundfiles in Group 2 can have a bit depth identical to Group 1. In
addition, if Group 1 has a bit depth of 24-bits, Group 2 can also have a
bit depth of 20- or 16-bits. If Group 1 has a bit depth of 20-bits, Group 2
can also have a bit depth of 16-bits.

9.5 Downmix Properties
When a 5.1 Surround Sound recording is played back over a stereo
sound system, the DVD-A player must mix 6 channels down to 2 channels. At the Album level, users can set default downmix parameters for
new Tracks that are created. Tracks can also have their own individual
downmix parameters.
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10 Appendix B: ReSolution
The DVD-A format has a data rate limitation of 9.6 MB/sec.
5 or 6 channels of 24/96 or 24/88.2 would exceed this data rate. The
ususal way around this problem is to use MLP encoding. This solution
can be used on the CHROME version of discWelder. STEEL, however,
has a unique feature that eliminates the need for the use of a costly
MLP encoder. We call this feature ReSolution.
ReSolution automatically recognizes when a track exceeds the 9.6 MB/
sec data rate limitation. It can automatically resample the data to a
lower data rate. 96kHz files are converted to 48 kHz, and 88.2kHz files
are converted to 44.1kHz.
When STEEL detects the need to resample, it will pop up a warning
window (see ). Click on “OK” to proceed with resampling.
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11 Appendix C: The Auto-Mirror
option
DVD-Video players are far more common than DVD-Audio players.
Some people are not aware of the difference between DVD-Audio and
DVD-Video, and will put a DVD-Audio disc into a DVD-Video player
and expect it to play.
And for the people who do understand the difference, sometimes a
DVD-Audio player is not available, but a DVD-Video player is.
In both of these cases, it would be nice if a DVD-Audio disc could play
in a DVD-Video player. This can be done by making a mirror of the
DVD-Audio material into a second section of the disc that is DVDVideo compatible. This dual-function disc is called a “universal” or
“hybrid” DVD-Audio disc.
discWelder STEEL has a great feature that can automatically create a
hybrid disc, called “Auto-Mirror”. This feature allows the author to
automatically create a VIDEO_TS (Video Zone) from the contents of
the AUDIO_TS (Audio Zone). It allows album playback on both DVDAudio and DVD-Video players (by creating a Universal DVD-A/V
disc). The audio tracks are encoded with an integrated SurCode Dolby
Digital (AC-3) encoder from the Tracks in the AUDIO_TS (Audio Title
Set), and the VIDEO_TS (video title set) is auto-formatted using the
integrated video authoring application.
The Auto-Mirror option creates a video main menu and a static slide per
Track, where the video Track slide comes from the slide on the audio
Track (if there is a slide or slides specified for the Track in the
AUDIO_TS). The SurCode Dolby Digital encoder automatically selects
the coding mode based on the channel format of each Track (5.1 surround or stereo).
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12 Appendix D: Dual-Layer discs
If your program material exceeds 4.7GB, it will not fit onto a standard
single-layer DVD-recordable disc. discWelder STEEL is capable of
creating dual-layer DVD-Audio discs. You will need to have a duallayer capable DVD burner, and blank DVD-9 discs.

12.1 Media Properties
When you have a dual-layer DVD burner connected to discWelder, it is
indicated in the Media Properties window (see Figure 12-1).

Figure 12-1
The Dual Layer window will say “Yes”, and a Layer Break value will be
indicated.
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12.2 During Recording
If the DVD burner supports dual-layer and has a dual-layer blank disk,
the “Show layer break details” checkbox will be enabled (see Figure 122).

Figure 12-2
If, during recording, discWelder STEEL detects that the material is
more than 4.7GB, the Layer Break details will be shown. Figure 12-3
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shows the first Layer Break dialog.

Figure 12-3
The dialog will indicate at which audio file the break occurs by listing it
in red. The break generally occurs at the beginning of the file.
The tree can be expanded to list the full pathname of the file (see Figure
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12-4).

Figure 12-4
The Layer Break file also displays the Layer Break sector offset when
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expanded (see Figure 12-5). Sectors are typically 2048 bytes.

Figure 12-5
discWelder STEEL automatically calculates the Layer Break offset, but
you can manually change it in the edit box at the bottom of the window.
The offset must be a multiple of 16.

12.3 During “Create Disc Image”
If the material is big enough to require dual layer, the Layer Break
Details window will come up (if the “Show layer break details” checkbox is checked). The Record Dialog is not displayed.

12.4 During “Write Disc Image”
First, the Record Dialog is displayed. Then, if the material is big
enough to require dual-layer, and if the “Show layer break details”
checkbox is check, the Layer Break Details windows will come up.
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